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gRINN is a software for residue interaction enery-based analysis of protein MD simulation trajectories.

Current version is v1.1.0.hf1.

Start with the Tutorial.

If you use gRINN for research or commercial purposes, please cite the following publication of gRINN in your
publication (article, thesis, etc.):

Contents: 1

tutorial.html
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CHAPTER 1

News

2018/11/27: Thank you for your interest in gRINN! We greatly appreciate your feedback. We’re aware of several
bugs, including incompatibility with some input data and gromacs versions, We’re currently working to fix them in
the next version release (anticipated January 2019). If you also experience problems, please feel free to send an email
to onursercin AT gmail DOT com!

1.1 Introduction

Welcome to gRINN (get Residue Interaction Energies and Networks).

gRINN is a software tool for residue interaction-energy based investigation of protein Molecular Dynamics simula-
tions.

Main functionality includes:

• Calculation of pairwise amino acid non-bonded interaction energies from NAMD or GROMACS generated
Molecular Dynamics (MD) simulation trajectories by interoperating with NAMD/GMX simulation engines.

• Equal-time linear correlations between interaction energy time series.

• Custom residue selections & multiple processor usage.

• A visualization interface for:

– Viewing pairwise interaction energies and their correlations alongside an embedded PyMol molecular
viewer.

– Protein Energy Network construction and visualization of simple residue-based local network metrics
(Degrees, Betweenness Centrality and Closeness Centrality)

– Shortest path analysis.

3
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1.2 Obtaining gRINN

gRINN is free and open to all users.

1.2.1 Dependencies

gRINN is designed to work with NAMD or GROMACS-generated MD simulation trajectories, hence topology, struc-
ture and trajectory files are required.

Moreover, the tool interoperates with NAMD or GROMACS, so you will need to provide the location of the NAMD
or GROMACS(gmx) executable you’ve used for your MD simulation before using gRINN.

Since you’re interested in using this tool, you’re probably already a user of either NAMD or GROMACS; however, if
the executable is for some reason not installed/located on your system, gRINN will not work. You should obtain
and install them from the respective developers as we can’t distribute them ourselves here.

Obtaining NAMD

Please use a non-CUDA multicore version.

Please note that downloading NAMD requires registration.

gRINN was tested against and confirmed to work fine with the following NAMD versions on Linux:

• NAMD 2.12b1, NAMD 2.12, NAMD 2.11, NAMD 2.10 and NAMD 2.9.

gRINN was tested against and confirmed to work fine with the following NAMD versions on Mac OSX High Sierra:

• NAMD 2.11 and 2.10.

WARNING: NAMD 2.12 and NAMD 2.12b1 MacOSX versions lead to hang ups during gRINN operation.
Please don’t use these versions.

Download NAMD here.

Obtaining GROMACS

gRINN was tested against and confirmed to work fine with the following GROMACS versions on Linux:

• gromacs 2016.1, 2016.2, 2016.3, 2016.4, 5.1.2, 5.1.4.

gRINN will surely not work with gromacs versions below 5.x and it may not be compatible with versions other
than those listed above.

Download GROMACS here.

1.2.2 Download gRINN

Please read the EULA first. By downloading and using gRINN, you agree to the terms and conditions contained
therein.

gRINN is available for both Linux (x64) and Mac OSX operating systems.

We recommend all users to download the latest version.

Download gRINN v.1.1.0.hf1 for Linux v64

Download gRINN v.1.1.0.hf1 for Mac OSX

4 Chapter 1. News

https://www.ks.uiuc.edu/Development/Download/download.cgi?PackageName=NAMD
http://www.gromacs.org/Downloads
license.html
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Download gRINN v.1.1.0 for Linux x64

Download gRINN v.1.1.0 for Mac OSX

Windows support is currently a work-in-progress. Stay tuned and visit back for a Windows compatible executable.

1.2.3 Starting the application

No installation is required.

Extract the archive you downloaded to a folder of your choice. Start a terminal in this folder and start the executable
by typing:

$ ./grinn

Please be patient for the application to start for the first time.

If you see the gRINN Main Window as shown below, you can continue with the Tutorial.

1.3 Tutorial

If you’re here for the first time, obtain gRINN first.

Sample data used in this tutorial is already bundled with gRINN, however the contents are extracted to a temporary
system folder which can be difficult to find. If you want to download it separately, click here.

1.3. Tutorial 5

https://www.dropbox.com/s/rijb1em1q83b0kf/grinn_linux_v110.tar.gz?dl=1
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download.html
https://www.dropbox.com/s/y0r87u8sxxyn8ty/grinn_samples_v101.tar.gz?dl=0
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1.3.1 Preparing input data

In this tutorial, we will use sample NAMD data from a short MD simulation of the trypsin enzyme which is already
prepared for gRINN. Therefore, preparation of any input data is not required for completing this tutorial. The steps
below describe the preparation steps you need to follow for your own data.

For NAMD/CHARMM-generated trajectories

When using your own data, you are advised to delete solvent molecules from your input Protein Data Bank (PDB),
Protein Structure File (PSF) and DCD files before using gRINN. If you don’t, a very high amount of RAM will
be required by gRINN for processing the trajectory file, particularly if you choose to use multiple CPU cores. The
completion time will increase significantly as well.

gRINN does not offer a function for removing the solvent molecules from input files, however this can be done using
standart software such as VMD.

If you have used psfgen or VMD’s Autopsf plug-in, usually the first PSF/PDB pair generated during system preparation
for MD simulation prior to solvation step is what you need. To remove the solvent from the DCD, you can load the
trajectory into VMD and save the coordinates of “protein” atoms into a new DCD file.

More information on removing non-protein atoms from input PSF/PDB/DCD files can be found here.

If you’re observing molecules/atoms breaking & jumping out of the simulation box during the simulation, you need
to “unwrap” them and save the resulting trajectory to a DCD file, then use that trajectory as input to gRINN. gRINN
does not handle such cases.

For GROMACS-generated trajectories

If you’re submitting a GROMACS trajectory, there is no need for additional data preparation. You can just give
your topology (TOP), run input (TPR) and trajectory (XTC or TRR) files as input to gRINN. However, a common
practice with protein MD simulations is to keep only protein atoms and remove solvent/ions from trajectory files to
save disk space unless solvent-protein interactions are the focus of a study. In this case, TPR and TOP files WITHOUT
non-protein atoms should be prepared for gRINN. More information on how to do that can be found here.

If you’re observing molecules/atoms breaking & jumping out of the simulation box during the simulation, you need to
remove PBC conditions with gmx trjconv and save the resulting trajectory to a new XTC/TRR file, and then use that
trajectory as input to gRINN.

1.3.2 Starting the Application

If you have not done already, start gRINN by following the steps here.

1.3.3 gRINN Main Window

Upon execution of grinn, the following window appears:
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miscellaneous.html
http://www.ks.uiuc.edu/Research/vmd/plugins/pbctools/
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This is the main window of gRINN. The links at the bottom direct the user to respective sections of this website.

gRINN offers two interfaces: New Calculation and View Results.

New Calculation: This interface is used for pairwise residue interaction energy and (optional) interaction energy
correlation calculations.

View Results: This interface is used to visualize results from New Calculation and construct Protein Energy Networks
using these data.

Go ahead and click on New Calculation now.

1.3.4 gRINN New Calculation

You should now see a window like the following one:

1.3. Tutorial 7
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This is the New Calculation interface. gRINN New Calculation is used to:

• specify paths to input files, NAMD/GMX executables and other custom calculation settings

• start interaction energy and/or correlation calculations

• monitor the progress of computation

• start “View Results” interface once the calculation is completed.

The New Calculation UI elements can be grouped into four main parts based on their functionality. These are shown
in the snapshot above in various color frames. We shall first describe the interface, then loading of sample NAMD
data and starting a calculation.

Input files, output folder and NAMD/GMX executable paths

The black frame includes UI elements for specifying the input files and the output folder.

8 Chapter 1. News
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Full paths to PDB/PSF/DCD files (in case of NAMD data) or TPR/TOP and XTC or TRR files (in case of GROMACS
data) can be specified either by typing/pasting the full file path to corresponding text edit boxes or via browsing by
clicking the “Browse for. . . ” buttons.

Note: Attention NAMD users! Please make sure that your full path lengths to your input files are not too long or else
NAMD exits with a Segmentation fault and gRINN has no way to detecting such errors at the moment.

Output folder specifies the folder in which gRINN results are stored. Note that the output folder you specify should
NOT exist prior to calculation. “Output Folder” button should be used as a convenience for selecting a parent
folder for your output folder. gRINN will create the output folder inside this parent folder.

The path of the NAMD/GMX executable is set to namd2 by default. This requires that a valid NAMD executable is
present in the executable search path of your system (in linux, this is the PATH environment variable). If namd2 is not
accessible via the executable search path, provide the full path here. The same logic applies to the gmx executable,
i.e. typing just gmx in this text box will assume that the gmx executable is accessible via the executable search path.

For NAMD, at least one additional parameter file containing the parameters included in the force-field you’ve used for
your simulation, is required. If you’ve used more than one parameter file, you can specify the full paths to these files
in the text box by leaving one blank space between them. Alternatively, you can put all parameter files in the same
directory and then select them via “Browse for Parameter File (NAMD)” button.

Calculation settings

The blue frame includes UI elements for specifying the settings used for non-bonded pairwise residue interaction
energy calculations.

1.3. Tutorial 9
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Solute dielectric (NAMD) specifies the dielectric constant that is used while computing the electrostatic component of
the interaction energy (dielectric keyword in the NAMD configuration file). The default value is 1.0, which means
that the electrostatic interactions will not be modified. Any value larger than this value lessens the electrostatic forces.
More information can be found in NAMD User Guide.

Selection 1 and Selection 2 define custom atom selections that include residue groups between which non-bonded
interaction energies will be computed. ProDy atom selection syntax is used here. (e.g. for selecting only the residues
of chain A that are within a certain cutoff distance (5 Angstroms) from residues of chain B and vice versa, you will
type chain A and within 5 of chain B in Selection 1 and chain B and within 5 of chain A
in Selection 2)

Note: This setting is useful if you’re only interested in pairwise residue interactions within a specific subset of your
protein. If you want a full characterization, leave these selections at the default settings (all). Note that using a custom
residue selection here will also lead to incorrect Protein Energy Network (PEN) construction while using the “View
Results” interface.

Percent cutoff and Filtering distance cutoff settings specify criteria for selecting pairs of residues between which non-
bonded interaction energies will be computed. Default values are 60% and 12 Angstroms, meaning that only pairs
of residues whose centers-of-mass come closer than 12 Angstroms in at least 60 percent of trajectory frames will be
included.

Non-bonded cutoff (NAMD) setting specific the cutoff distance for non-bonded energy calculations by NAMD
(Angstroms). In other words, all non-bonded atom-atom interactions beyond this cutoff distance will be ignored.
Note that this settings does not apply to GROMACS trajectories (all calculation settings are as specified in the
input TPR file)

Trajectory stride specifies a stride value for the input trajectory. For example, if you have 1000 frames in your
trajectory and set a value of 10 here, every 10th frame will be included in the calculation, yielding a total of 100
frames. Default stride value is 1 (all frames are included).

Number of processors specify the number of CPU cores to be used. The default value is the number of cores available in
your system. This option is useful in cases where you have another CPU-intensive process running in the background
and don’t want to employ all available resources for gRINN.

Correlation settings

The red frame includes UI elements for activating residue interaction energy correlation (Pearson’s product moment
correlation).

10 Chapter 1. News
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Calculate residue interaction correlation as well check box enables/disables correlation calculation between all pair-
wise residue interaction energy time series computed.

Average interaction energy cutoff specifies a cutoff for correlation calculations. Interactions with mean energy values
below this cutoff value will be excluded from correlation calculations. Default value is set to 1 kcal/mol.

Note: Correlations are reported only if the value is significant (i.e. Pearson’s r above 0.4) to reduce the noise in the
reported data and maintain a manageable output file size.

Starting and monitoring the calculation

The yellow frame on the right side of the UI includes two buttons for starting and stopping the calculation and three
progress bars to monitor the percentage of completion of the three steps involved in the calculation. Finally, at the
bottom, a button to start View Results interface is included, which becomes activated once an interaction energy
calculation task is successfully completed.

CALCULATE button, when pressed, will first check the input (files, settings, whether the output folder exists, etc.). If
valid input is detected, computation starts with filtering the interacting pairs. Pairwise residue interaction energies are
computed in the second step. Final step, correlation, is done only if the corresponding checkbox is selected.

STOP button is for stopping the operation of gRINN. This is useful if you notice that you need to change a setting after
starting the operation or simply want to cancel it.

Note: Note that the STOP button does not pause the operation. You need to start all over again if you click on this
button (A warning is spawned for confirmation to prevent accidental clicking here).

1.3. Tutorial 11
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Start calculation with sample NAMD data

Let’s load some sample data and start a calculation to see how gRINN works. Click on load sample NAMD data and
settings.

You will see that the input file UI elements are now populated with some values. The top three text boxes include
paths to PDB, PSF and DCD files from a 50 nanoseconds-long MD simulation of bovine cationic trypsin (structure
extracted from PDB id 3OTJ).

Note: Note that the PSF and PDB files correspond to a step prior to solvation step during preparation of the system
for MD simulation using VMD and psfgen. Solvent molecules in the DCD trajectory were removed by using VMD.

Note: The DCD file corresponds to an equilibrium stage of the simulation (between 25 and 50 nanoseconds). A stride
value of 25 was applied in order to reduce the file size bundled with gRINN.

The path of the output folder is set to grinn_output in the current working directory. It is safe to change this path as
long as it does not exist before starting the calculation.

The path of the NAMD executable is set to namd2 by default. This requires that a valid NAMD executable is present in
the executable search path of your system (in linux, this is the PATH environment variable). If namd2 is not accessible
via the executable search path, provide the full path here.

Parameter file text box is now filled with the path of the parameter file used for the sample MD simulation.

Click on CALCULATE now. After an initial input checking step, gRINN should start by filtering the residue pairs to be
included in the interaction energy calculation. Once this is complete, interaction energies will be calculated, followed
by equal-time correlation calculations. Depending on the capacity of your computer, the operation will take some time
between a few minutes and an hour or two. You can follow the progress by keeping an eye on the progress bars which
will show the estimated amount of remaining time as well.

Once gRINN finishes operation, you will be notified and VIEW RESULTS button will be enabled. You can now
proceed to viewing the results either by clicking this button or View Results button on the gRINN Main Window.

1.3.5 gRINN View Results

Upon starting View Results interface, you will be immediately prompted to browse and select a folder containing
results from the previous step in gRINN.

Go ahead and select this output folder now.

If the folder is valid, you will see the message Please click OK to start loading your data. . . . Just click OK to proceed.

After some time, another message will appear, saying A trajectory exists in your output folder. Would you like to load
it as well? Warning: This might slow down the display significantly if the trajectory file size is large.. Click Yes to
proceed.

Note: If you choose No here, the trajectory will not be loaded and the sliding bar to control the frame displayed in
the molecular viewer embedded in the interface (see below) will be disabled.

Once all of the output is loaded into the UI, you will see the View Results interface looking like the following figure:
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View Results interface can be separated into three main parts based on the functionality of UI elements.

The black frame includes a text box and a button for selecting an output folder. Upon selecting an output folder by
using the button, the contents of that folder (if it is a valid gRINN output folder) will be loaded, discarding the currently
displayed output (if there’s any).

The red frame includes an embedded molecular viewer (which is a PyMol instance) that is updated upon interaction
with the blue frame UI elements. How this occurs is explained in the relevant sections of each tab below. The PyMol
viewer allows zoom-in and out (rmb), rotation (lmb while on protein) and translation (middle mouse button) modes.

The blue frame includes UI elements, organized into several tab panels. The results displayed in this section are
extracted from the files included in the output folder. The content of each tab is explained below.

Pairwise Energies

Pairwise Energies tab includes several UI elements that display individual pairwise residue interaction energies. The
UI looks like the following:

1.3. Tutorial 13
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On the left, a table displays average interaction energies between selected pairs of residues. Due to the excessively
high number of all possible pairwise interactions even in a small protein, not all pairs are displayed at once in this
table. Instead, only one interaction pair is selected at one time via clicking relevant cells of the table. The selected
item of the first column determines the first residue in an interaction pair. The selected item of the second column
determines the second residue in an interaction pair.

So, for example, if you click on residue EGLN64 in the leftmost column, the average interaction energies of all other
residues with this residue are displayed in the third column of the table. In addition to this, the vertical bar plot right
next to the table is updated to reflect non-zero interaction energies of all other residues with EGLN64. If you then click
on EASN34 in the second column or on the bar plot, the interaction pair is updated as EGLN64 and EASN34. This
will cause the plots on the right hand side of this tab to reflect interaction energy time series and energy distribution
belonging to these two residues over the trajectory frames.

Note: gRINN identifies residues with chain ID, amino acid type (three-letter code) and the residue number. For
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example, EASN34 means the residue 34 (ASN) of chain E in the protein structure.

Once you select an interaction pair this way, the protein structure that is displayed in the molecule viewer embedded
on the right will reflect this pair of residues as well.

Note: gRINN uses kcal/mol as the energy unit.

Note: Note that some interaction energies will be negative (attractive) and some will be positive (repulsive).

Interaction Energy Matrix

Interaction Energy Matrix tab includes a heat map that displays average interaction energies between all pairs of
residues:

1.3. Tutorial 15
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The heatmap shows so-called energetic “hot-spots” in the protein structure. Many of these spots correspond to sec-
ondary structure elements, disulfide bonds as well as residues that are not sequence neighbors but in close contact with
each other in the folded protein structure. The heatmap can be zoomed in & out and saved into a file using the toolbar
included above. The upper and lower boundaries of the heatmap can be adjusted by using the sliding bar located on
the right-hand side of the heatmap. The boundary setting affects the total range from negative to positive interaction
energies.

Double-clicking on a cell on this heatmap will update the right pane molecule viewer to reflect the selected residue
pair on the protein structure.

Interaction Energy Correlations

Interaction Energies Correlations tab includes several UI elements that display data related to equal-time linear cor-
relations between interaction energy time series:
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The table here displays a list of the pairs of residues involved in a specific correlation (with the first two columns
indicating the two residues in the first interaction pair and the third and fourth columns indicating the two residues in
the second interaction pair). The last column shows the correlation value.

Clicking on a row in this table will update the two plots next to the table. The top plot shows the interaction energy
series involved in the correlation against trajectory frames. In the bottom, a plot of these two series against each other
is displayed. The right pane molecular viewer will be updated to highlight the four residues involved in the correlation.

Residue Correlation Matrix

Residue Correlation Matrix tab includes a heatmap showing the “Residue Correlation Matrix” (RC Matrix) that is
constructed using the interaction energy correlations. RC matrix is one way of extracting dynamical correlation infor-
mation from interaction energies of residue pairs in the structure.

1.3. Tutorial 17
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The matrix is constructed to be able to map the correlation values on the three dimensional structure [KK2009]. In
other words, the correlation values are translated into a residue-residue type of information. The matrix is an NxN
square matrix (N being the number of residues in the structure) and is constructed by considering the mutual occurence
of a given pair of residues in both sides of a correlation. For example, if the correlation between the interaction
EGLY142-ELYS145 and the interaction EILE16-ELYS145 is 0.6 and the correlation between the interaction EGLY16-
ELYS223 and the interaction EGLY142-EASP191 is -0.5, the residue correlation between EILE16 and EGLY142
would be the sum of the absolute values of these two correlation coefficients (which is 1.1))*0 This summation is
performed for all calculated correlations for each residue pair in the structure.

Like the interaction energy matrix, the heatmap can be zoomed-in and out. Double-clicking a cell in the heatmap will
highlight the corresponding residue pair in the right pane molecular viewer.

0 Note that the values given here are exemplary and do not reflect the values you’ve just inspected in the previous tab.
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Network Analysis

Protein Energy Network (PEN)

The term “Protein Energy Network” has been used for the first time by Vijayabaskar and Vishveshwara [VV2010] in a
study where they constructed such networks of protein structures using pairwise residue interaction energies computed
over ensembles of structures obtained from MD simulations.

In this method, a network is constructed by taking individual residues as nodes and average interaction energies
between each residue pair as the “weight” for edges that are added between these residue nodes. Once the network
is constructed, local (node-based) network metrics, such as degree, closeness and betweenness centralities can be
obtained to assess the importance of each residue in terms of protein stability and dynamics.

gRINN constructs such a network once you load an output folder into the View Results interface. Each residue in the
structure is taken as a node in the PEN. Edges are added if the absolute value of the interaction energy between any
two residues is greater than a cutoff value. This cutoff can be set by changing the Edge addition energy cutoff value.

Adding an edge between two residues implies that they have a significant interaction. Yet, the way how the strength
of this interaction is defined changes the results of global residue-based network metrics such as centrality values and
shortest path analysis. Values of average interaction energies can be used to assign a relative strength (weight) value
to an edge. Accordingly, an edge is added using the following general criteria:

In the above equation, 𝜔𝑖𝑗 denotes the edge weight between residues i and j. 𝜒𝑖𝑗 denotes the average interaction energy
between residues i and j. Note that the addition of edges between covalently bound residues is optional (see below).

𝜒𝑖𝑗 is computed using the following formula:

In this equation, 𝜖𝑖𝑗 denotes the average interaction energy between residues i and j and 𝜖𝑎𝑡𝑡 denotes the array of
attractive (negative) interaction energies. Note that this equation favors attractive interactions: the more attractive
(negative) an interaction is, the higher weight will be assigned to the edge of that specific interaction. Repulsive
interactions obtain zero weight.

Network Analysis Tab

Network Analysis tab includes UI elements for inspecting the node-level (residue-level) metrics and shortest paths in
a Protein Energy Network (PEN) constructed by using the interaction energy matrix.

It is possible to include/exclude covalent bonds as edges and specify an interaction energy cutoff for edge addition
using the respective checkbox and the spinbox at the top of this tab panel. It is necessary to update the network by
clicking the Update Network button if these settings are changed.

Residue Metrics tab here shows three types of local metrics (node/residue-based): Degree, Betweenness Centrality
and Closeness Centrality.
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Shortest Paths tab allows the user to select a source and a target residue and find all alternative short pathways be-
tween these two residues within the structure of the PEN. The shortest paths are found by using Dijkstra’s algorithm
[DEW1959]. Note that since this algorithm favors edges with lower weights and in reality we want stronger interac-
tions to be preferred in a short path (which have higher edge weights), a new edge property (distance) is assigned to
each edge by calculating 1− 𝜒𝑖𝑗 and this distance value is considered as the edge weight when employing Dijkstra’s
algorithm.
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Upon clicking a path in the shortest path table, the right pane molecular viewer will be updated to reflect the path.

References

Output folder content

If gRINN completes the operation successfully, you should see the following files in the output folder:

• traj_dry.dcd

• system_dry.psf

• system_dry.pdb

• network.gml

• grinn.log
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• energies_resIntCorr.csv (if you enabled interaction energy correlation)

• energies_resCorr.dat (if you enabled interaction energy correlation)

• energies_intEnVdW.csv

• energies_intEnTotal.csv

• energies_intEnMeanVdW.dat

• energies_intEnMeanTotalList.dat

• energies_intEnMeanTotal.dat

• energies_intEnMeanElec.dat

• energies_intEnElec.csv

• energies.pickle

traj_dry.dcd includes the frames of your input trajectory that were used by gRINN. View Results interface reads
conformations of protein structure into the PyMol instance from this file.

system_dry.psf and system_dry.pdb contain your input protein structure topology and coordinates.

grinn.log is the log file produced by gRINN.

energies_resIntCorr.csv includes data displayed in Interaction Energy Correlations tab in View Results interface in
comma-separated values (CSV) format.

energies_resCorr.dat includes the RC matrix that is displayed as heatmap in Residue Correlations tab.

energies_intEnVdW.csv includes non-bonded Van-der Waals interaction energies in CSV format.

energies_intEnTotal.csv includes non-bonded Total interaction energies (sum of Van der Waals and Electrostatic
energies) in CSV format.

energies_intEnElec.csv includes non-bonded Electrostatic interaction energies in CSV format.

energies_intEnMeanVdW.dat includes average non-bonded Van der Waals interaction energy matrix between all
pairs of amino-acids.

energies_intEnMeanElec.dat includes average non-bonded Electrostatic interaction energy matrix between all pairs
of amino-acids.

energies_intEnMeanTotal.dat includes average non-bonded Total interaction energy matrix between all pairs of
amino-acids. This data is displayed as heatmap in Interaction Energy Matrix tab.

energies.pickle is a pickled dictionary which contains all pairwise interaction energies between residues in protein
structure. Once loaded into a Python working environment, the energy time series between specific residue pairs can
be accessed as folows:

import pickle
energies = pickle.load(open('energies.pickle','r'))
energies['EASN34-EGLN64']['Total']

1.3.6 gRINN with GROMACS data

gRINN can work with GROMACS-generated data and interoperate with the gmx executable.

Click on load sample GMX data and settings. The top three UI elements will contain a TPR, TOP and an XTC
(gromacs trajectory). The data were obtained from the equilibrium section (25-50ns) of a 50ns-long MD simulation
of a peptide-loade Major Histocompatibility Complex (pMHC, PDB ID: 1EEY).
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Note: The sample files include a trajectory which was simulated with the CHARMM 27 force-field. Please make
sure that your gromacs installation includes this force-field.

Note: You definitely need a TPR file. Supplying a PDB as input for GROMACS data will cause gRINN to look for
PSF & DCD files.

Note: If your TPR file includes only a single protein chain, gRINN will assign a default chain ID of P to all residues.

Click on CALCULATE. Depending on the capacity of your computer, the operation will last between a few minutes to
one-two hours. Once computation finishes, you can VIEW RESULTS as described above.

Note: GROMACS uses SI units of kJ/mol. This is converted to kcal/mol by gRINN.

1.3.7 gRINN Command-Line Interface

gRINN offers a command-line interface for interaction energy and correlation calculations as well. This is mostly
useful if you decide to use gRINN for a batch of trajectories. You can include several gRINN commands in a e.g. shell
script.

Command-line interface is activated by providing additional flags to grinn. Three modes are available here: -calc,
-corr or -results. -results mode is used just for starting the VIEW RESULTS interface directly instead of
starting the main window first.

You can get a full of list of flags and their explanations by typing ./grinn --help in the terminal (or grinn
--help if the executable is not in the current working directory) . Some examples are included below:

The following command will take 3otj_typsin_psfgen.pdb, 3otj_trypsin_psfgen.psf and
3otj_trypsin_25_50ns_dry_str25_aligned.dcd and par_all27_prot_lipid_na.inp as input files from the current
working directory, assume that namd2 is present in the executable search path, apply a stride of 10 on the input
trajectory and start an interaction energy calculation using 16 CPU cores by taking only residue pairs whose
centers-of-mass come closer than 20 Angstroms in at least 75% of the trajectory frames with a 12 Angstroms cutoff
for non-bonded energy computation. The results will be saved to folder grinn_output, which will be created in
the current working directory.

$ grinn -calc --pdb 3otj_trypsin_psfgen.pdb --top 3otj_trypsin_psfgen.psf
--traj 3otj_trypsin_25_50ns_dry_str25_aligned.dcd --parameterfile par_all27.inp
--stride 10 --exe namd2 --pairfiltercutoff 20 --cutoff 12 --pairfilterpercentage 0.75
--outfolder grinn_output --numcores 16

The above command does not compute interaction energy correlations. If you want to include interaction energy
correlations, you need to provide the --calccorr flag:

$ grinn -calc --pdb 3otj_trypsin_psfgen.pdb --top 3otj_trypsin_psfgen.psf
--traj 3otj_trypsin_25_50ns_dry_str25_aligned.dcd --parameterfile par_all27.inp
--stride 10 --exe namd2 --pairfiltercutoff 20 --cutoff 12 --pairfilterpercentage 0.75
--outfolder grinn_output --numcores 16 --calccorr --corrintencutoff 1

This will include correlation calculations for average interaction energies above 1 kcal/mol.
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Alternatively, you can compute correlations separately after using -calc mode with the --calccorr flag. For this,
use the -corr mode. This time, you need to provide the path to the CSV file that includes interaction energy time
series. The results will be stored in the folder in which this CSV file is located.

$ grinn -corr --corrinfile grinn_output/energies_intEnTotal.csv

For GROMACS-generated data, just replace the --exe flag with the path to the gmx executable (or type --exe
gmx if gmx is available in the executable search path), use --tpr flag instead of --pdb and provide your TOP and
XTC/TRR files instead of PSF and DCD files as above.

1.4 Miscellaneous

1.4.1 Preparing NAMD/CHARMM input data for gRINN

gRINN has mainly two requirements in order to be able to process NAMD/CHARMM type simulation data efficiently:

1. “Dry” PSF/PDB/DCD files

2. PDB file with chain IDs assigned for all atoms.

Deleting non-protein atoms from PSF/PDB files

It is fairly easy to remove non-protein atoms from input PDB/PSF/DCD files using VMD. Below we describe the steps
in VMD (You need to have VMD installed on your computer).

• Start vmd from the directory in which your psf and pdb files are located by typing vmd in a terminal.

• Save the following lines of Tcl code to a file named make_dry_psf.tcl into your current working directory.

mol load psf ionized.psf pdb ionized.pdb

set a [atomselect top "not protein"]
set l [lsort -unique [$a get segid]]

package require psfgen
readpsf ionized.psf
coordpdb ionized.pdb

foreach s $l {
delatom $s
}

writepsf ionized_dry.psf
writepdb ionized_dry.pdb

• Replace the ionized.psf, ionized.pdb, ionized_dry.psf and ionized.pdb with the file names of your psf/pdb and
your desired output file names.

• Run the tcl script by starting the TkConsole from VMD Main Window (Extensions>TkConsole) and typing
source make_dry_psf.tcl.

• You should have obtained a psf/pdb file pair WITHOUT non-protein atoms now. Use them as input to gRINN.

Note: If you don’t have chain IDs assigned in your PDB file, you will need to add chain IDs as well (see below).
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Deleting non-protein atoms from DCD trajectory files

• Start vmd from the directory in which your psf and pdb files are located by typing vmd in a terminal.

• Load your psf file (e.g. ionized.psf) INCLUDING all atoms included in your simulation by choosing (File ->
New Molecule) from VMD Main Window.

• Load your trajectory (dcd) onto this psf file by choosing (File -> New Molecule) and selecting “Load Files
for. . . ” option.

• Save a new trajectory file by choosing the molecule in Main Window, right-clicking on it and selection “Save
Coordinates” option. Then, type “protein” to the “Selected Atoms” field and select “DCD” as the file-type.
Click on “Save”.

• Use this new DCD file as input to gRINN.

(Re)-assigning chain IDs back to the PDB file

A typical case for the PDB files that are prepared for NAMD/CHARMM simulations is that the chain IDs are deleted
from the PDB and segment column is filled instead.

This is a problem for gRINN, since it distinguished between different residues by their chain IDs and residue numbers.
If there is even a single atom with no chain IDs assigned in an input PDB file, gRINN will complain and refuse to
process that file.

It is possible to (re)-assign chain IDs back to PDB files by using any software with PDB manipulation capabilities. A
simple option here would be the PDBEditor software. In order to change or add chain IDs to a PDB file, follow the
steps listed below:

• Start PDBEditor.jar (you will need to have Java installed on your computer with necessary security permissions)

• Go to File -> Open Coordinate File, and select your PDB file.

• Go to Modify -> Edit Residue Number & Chain ID.

• Type in a chain ID into the “New Chain ID” column. You should see that all other chain IDs are appropriately
assigned.

• Click on “Apply Changes”, then save your PDB file.

• Use this new PDB file as input to gRINN.

1.4.2 Deleting non-protein atoms from GROMACS input data

If you’re submitting a GROMACS trajectory, there is no need for additional data preparation. You can just give
your topology (TOP), run input (TPR) and trajectory (XTC or TRR) files as input to gRINN. However, a common
practice with protein MD simulations is to keep only protein atoms and remove solvent/ions from trajectory files to
save disk space unless solvent-protein interactions are the focus of a study. In this case, TPR and TOP files WITHOUT
non-protein atoms should be prepared for gRINN. We describe here a step-by-step procedure to make TPR,TOP and
TRR/XTC files that don’t include any non-protein atoms.

Deleting non-protein atoms from TOP files

The only required action here is to delete lines containing non-protein atoms in the topology (TOP) file. For example,
if your top file contains a certain number of water molecules, the end of the file might look like the following:
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[ molecules ]
; Compound #mols
Protein_chain_A 1
Protein_chain_B 1
Protein_chain_C 1
SOL 24933
NA 8

Simply delete the lines beginning with SOL and NA:

[ molecules ]
; Compound #mols
Protein_chain_A 1
Protein_chain_B 1
Protein_chain_C 1

Save this file with a new file name (e.g. mytopol_dry.top) and use it as input to gRINN.

Deleting non-protein atoms from TPR files

The TPR file contains all information that is necessary to start an MD simulation with GROMACS. Making a new
TPR file without any non-protein atoms is a bit more complicated than generating a “dry” topology file. The steps are
described below:

• First, extract a PDB file from your TPR by calling gmx editconf in a terminal window:

gmx editconf -f mytpr.tpr -o mypdb.pdb

• Then, delete all non-protein atoms from this PDB file (using a suitable text edit, e.g. Sublime Text) and save it
as e.g. “mypdb_dry.pdb”.

• Next, modify your simulation input MDP file such that it does not contain any solvent/ion related parameters. In
other words, prepare it as if you’re going to run a simulation in vacuo. For example, if your MDP file contains
such lines:

; Temperature coupling
tcoupl = V-rescale
tc-grps = Protein Non-Protein
ref_t = 310 310

simply delete them. Then, save the file as e.g. “mymdp_dry.mdp”.

• Next, create a new TPR file using your dry PDB and MDP files by calling gmx grompp:

gmx grompp -f mymdp_dry.mdp -c mypdb_dry.pdb -p mytopol_dry.top -o mymd_dry.tpr

• Use the resulting TPR as input to gRINN.
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1.5 Issues and History/Change Log

1.5.1 Known Issues - To-do List

Planned features/fixes (short-term)

• (Fixed in v1.1.0.hf1) gRINN fails to process GROMACS-generated TPR files in which no chain ID is present.
This appears to be the case where only a single protein chain is included. This will be fixed in the next version.

• gRINN log file will include parameters used when calling gRINN.

• (Fixed in v1.1.0.hf1) gRINN fails to display IEMs and RCs for proteins with less than 100 amino acids. This
will be fixed in the next version.

• gRINN will let the user export computed shortest paths list.

• Exported networks will include better residue labeling instead of simple integers.

• NAMD won’t be spawned multiple times, letting the user give as input larger DCD files and avoid insufficient
memory errors.

• Input file window will be simplified, avoiding the confusion on file types for NAMD/GROMACS data.

• Switching will be optional for NAMD-type data, as opposed to the current implementation (off)

Planned features/fixes (longer-term)

• Support for non-protein residues (organic ligands, lipids, nucleic acids).

• Chain ID requirement on input files should be removed. We are working on code to relax this requirement.

• View Results UI will allow visualization of Electrostatic and vdW energies separately, in addition to separate
network analysis features.

• A windows-compatible version is on the way.

Planned features/fixes (unlikely to implement in foreseeable future)

• Support for AMBER-generated trajectories.

1.5.2 v1.1.0.hf1 (2018/06/21)

This hf (hot-fix) version fixes two bugs which rendered gRINN unusable in some cases and an addition to sample input
files:

Bug fixes:

• A major bug in gRINN which leads to a failure in processing TPR files without chain IDs is corrected. gRINN
will assign a default chain ID of “P” to residues which have no chain IDs assigned in input TPR.

• IEM annotation is now shown only for smallest proteins (with sizes of at most 20 amino acids).

Additions:

• charm27.ff files (used by GROMACS sample trajectory data) are included in the distribution (considering that
this force-field may not be included in GROMACS installation of some users).
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1.5.3 v1.1.0 (2018/04/06)

This version introduces a major internal code rehaul, leaving major features of gRINN unaffected. There are additional
new features as well as major/minor bug fixes:

New Features:

• A new calculation setting for non-bonded interaction cutoff for NAMD simulation input is introduced. In the
previous version, filtering cutoff distance parameter specified both the filtering cutoff distance itself and the
non-bonded interaction energy cutoff for NAMD simulation input.

• gRINN now supports Charmm simulation input as well.

Major/minor bug fixes:

• A bug which caused faulty reading of more than one parameter file for NAMD simulation input is fixed.

• A minor bug which caused incorrect protein structure display upon start of View Results interface in Mac OS
version is fixed.

1.5.4 v1.0.1 (2017/12/27)

Initial release of gRINN.

1.6 FAQ

gRINN is fresh out-of-box software! We are still preparing a list of “Frequently Asked Questions” list to serve
as clarifications regarding the use of the tool. Still, real FAQs will come up as you use the software and direct
questions/comments at us. Please contact either Onur or Pemra directly:

onursercin AT gmail DOT com

pemra DOT ozbek AT marmara DOT edu DOT tr

1.7 Credits

The core functionality of gRINN is provided by NAMD and GROMACS MD simulation software.

gRINN was written in Python programming language (version 2.7). In addition to the Python core library, several
open source Python packages are used to provide the following functionality:

PyQt5 (a python wrapper around the Qt desktop application development environment, v5.6.0) is used for all GUI
elements.

matplotlib (v2.0.2) and seaborn (v0.8.1) are used to display two-dimensional line and scatter plots as well as heatmaps
included in the “View Results” interface.

ProDy (v1.9.3) is used for PDB and DCD trajectory manipulations, atom selections and all other general geometric
tasks related to protein structures.

Mdtraj (v1.9.0) is used to convert GROMACS trajectory file formats to DCD for further processing using ProDy.

PyMol by Schrödinger (open source version v1.9.0.0) is used as the embedded molecule viewer in the “View Results”
interface of gRINN.

pexpect (v4.3.1) is used to interact with gmx executable from within Python environment.
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Numpy (v1.13.3) is used for all operations related to matrices, which occur throughout the computation workflow of
gRINN.

pandas (v0.20.3) is used to store, process and save data throughout the computational workflow of gRINN.

networkx (v2.0) is used to construct Protein Energy Networks and calculation of local network metrics and shortest
paths.

gRINN’s logo, Shamrock lucky Icon was designed by www.iconka.com

1.8 Citing gRINN

If you use gRINN for research or commercial purposes, please cite the following publication of gRINN in your
publication (article, thesis, etc.):

1.9 Source Code

If you’d like to contribute to the development of gRINN or have a specific need that requires tweaking of the source
code, here it is:

gRINN (Bitbucket repository)

1.10 Contact

gRINN is developed and maintained primarily by Onur Serçinoğlu. For all technical is-
sues/questions/requests/problems, please contact him directly at onursercin AT gmail DOT com. You may
want to visit this page <history.html> to see a list of issues he’s aware of and planned fixes/features for the upcoming
versions of gRINN.

For all scientific questions/discussions, contact the Principal Investigator (Dr. Pemra Ozbek) directly at pemra DOT
ozbek AT marmara DOT edu DOT tr.

gRINN was part of Onur’s work in Pemra Ozbek’s lab at Marmara University Department of Bioengineering Compu-
tational Biology and Bioinformatics Research Group

1.11 License

This page contains the End User License Agreement (EULA) of gRINN. Please read and make sure you agree to this
agreement before downloading gRINN.

gRINN Developers: Onur Serçinoğlu (onursercin@gmail.com) Pemra Ozbek (pemra.ozbek@marmara.edu.tr)

This End-User License Agreement (“EULA”) is a legal agreement between you and gRINN Developers.

This EULA agreement governs your acquisition and use of our gRINN software (“Software”) directly from gRINN
Developers.

Please read this EULA agreement carefully before using the gRINN software. It provides a license to use the gRINN
software and contains warranty information and liability disclaimers.

Upon starting the gRINN application, you are confirming your acceptance of the Software and agreeing to become
bound by the terms of this EULA agreement.
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If you are entering into this EULA agreement on behalf of a company or other legal entity, you represent that you have
the authority to bind such entity and its affiliates to these terms and conditions. If you do not have such authority or if
you do not agree with the terms and conditions of this EULA agreement, do not use the Software, and you must not
accept this EULA agreement.

This EULA agreement shall apply only to the Software supplied by gRINN Developers herewith regardless of whether
other software is referred to or described herein. The terms also apply to any gRINN Developers updates, supplements,
Internet-based services, and support services for the Software, unless other terms accompany those items on delivery.
If so, those terms apply.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

1.11.1 License Grant

gRINN Developers hereby grants you a personal, non-transferable, non-exclusive licence to use the gRINN software
on your devices in accordance with the terms of this EULA agreement.

You are permitted to load the gRINN software under your control. You are responsible for ensuring your device meets
the minimum requirements of the gRINN software.

gRINN is free and open to all users.

If you use gRINN for research or commercial purposes, please cite the following publication of gRINN in your
publication (article, thesis, etc.):

You are not permitted to:

• Reproduce, copy, distribute or resell the software.

• Allow any third party to use the Software on behalf of or for the benefit of any third party.

• Use the Software in any way which breaches any applicable local, national or international law.

• use the Software for any purpose that gRINN Developers consider as a breach of this EULA agreement.

1.11.2 Third-party tools included in gRINN:

gRINN is based on Python 2.7. Python is available under a Python license:

Python 2.7 license
This is the official license for the Python 2.7 release:

A. HISTORY OF THE SOFTWARE
==========================

Python was created in the early 1990s by Guido van Rossum at Stichting
Mathematisch Centrum (CWI, see http://www.cwi.nl) in the Netherlands
as a successor of a language called ABC. Guido remains Python's
principal author, although it includes many contributions from others.

In 1995, Guido continued his work on Python at the Corporation for
National Research Initiatives (CNRI, see http://www.cnri.reston.va.us)
in Reston, Virginia where he released several versions of the
software.

(continues on next page)
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(continued from previous page)

In May 2000, Guido and the Python core development team moved to
BeOpen.com to form the BeOpen PythonLabs team. In October of the same
year, the PythonLabs team moved to Digital Creations (now Zope
Corporation, see http://www.zope.com). In 2001, the Python Software
Foundation (PSF, see http://www.python.org/psf/) was formed, a
non-profit organization created specifically to own Python-related
Intellectual Property. Zope Corporation is a sponsoring member of
the PSF.

All Python releases are Open Source (see http://www.opensource.org for
the Open Source Definition). Historically, most, but not all, Python
releases have also been GPL-compatible; the table below summarizes
the various releases.

Release Derived Year Owner GPL-
from compatible? (1)

0.9.0 thru 1.2 1991-1995 CWI yes
1.3 thru 1.5.2 1.2 1995-1999 CNRI yes
1.6 1.5.2 2000 CNRI no
2.0 1.6 2000 BeOpen.com no
1.6.1 1.6 2001 CNRI yes (2)
2.1 2.0+1.6.1 2001 PSF no
2.0.1 2.0+1.6.1 2001 PSF yes
2.1.1 2.1+2.0.1 2001 PSF yes
2.2 2.1.1 2001 PSF yes
2.1.2 2.1.1 2002 PSF yes
2.1.3 2.1.2 2002 PSF yes
2.2.1 2.2 2002 PSF yes
2.2.2 2.2.1 2002 PSF yes
2.2.3 2.2.2 2003 PSF yes
2.3 2.2.2 2002-2003 PSF yes
2.3.1 2.3 2002-2003 PSF yes
2.3.2 2.3.1 2002-2003 PSF yes
2.3.3 2.3.2 2002-2003 PSF yes
2.3.4 2.3.3 2004 PSF yes
2.3.5 2.3.4 2005 PSF yes
2.4 2.3 2004 PSF yes
2.4.1 2.4 2005 PSF yes
2.4.2 2.4.1 2005 PSF yes
2.4.3 2.4.2 2006 PSF yes
2.5 2.4 2006 PSF yes
2.7 2.6 2010 PSF yes

Footnotes:

(1) GPL-compatible doesn't mean that we're distributing Python under
the GPL. All Python licenses, unlike the GPL, let you distribute
a modified version without making your changes open source. The
GPL-compatible licenses make it possible to combine Python with
other software that is released under the GPL; the others don't.

(2) According to Richard Stallman, 1.6.1 is not GPL-compatible,
because its license has a choice of law clause. According to
CNRI, however, Stallman's lawyer has told CNRI's lawyer that 1.6.1
is "not incompatible" with the GPL.

(continues on next page)
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Thanks to the many outside volunteers who have worked under Guido's
direction to make these releases possible.

B. TERMS AND CONDITIONS FOR ACCESSING OR OTHERWISE USING PYTHON
===============================================================

PYTHON SOFTWARE FOUNDATION LICENSE VERSION 2
--------------------------------------------

1. This LICENSE AGREEMENT is between the Python Software Foundation
("PSF"), and the Individual or Organization ("Licensee") accessing and
otherwise using this software ("Python") in source or binary form and
its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF
hereby grants Licensee a nonexclusive, royalty-free, world-wide
license to reproduce, analyze, test, perform and/or display publicly,
prepare derivative works, distribute, and otherwise use Python
alone or in any derivative version, provided, however, that PSF's
License Agreement and PSF's notice of copyright, i.e., "Copyright (c)
2001, 2002, 2003, 2004, 2005, 2006 Python Software Foundation; All Rights
Reserved" are retained in Python alone or in any derivative version
prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on
or incorporates Python or any part thereof, and wants to make
the derivative work available to others as provided herein, then
Licensee hereby agrees to include in any such work a brief summary of
the changes made to Python.

4. PSF is making Python available to Licensee on an "AS IS"
basis. PSF MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR
IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND
DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON WILL NOT
INFRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS
A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON,
OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material
breach of its terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any
relationship of agency, partnership, or joint venture between PSF and
Licensee. This License Agreement does not grant permission to use PSF
trademarks or trade name in a trademark sense to endorse or promote
products or services of Licensee, or any third party.

8. By copying, installing or otherwise using Python, Licensee
agrees to be bound by the terms and conditions of this License
Agreement.

(continues on next page)
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BEOPEN.COM LICENSE AGREEMENT FOR PYTHON 2.0
-------------------------------------------

BEOPEN PYTHON OPEN SOURCE LICENSE AGREEMENT VERSION 1

1. This LICENSE AGREEMENT is between BeOpen.com ("BeOpen"), having an
office at 160 Saratoga Avenue, Santa Clara, CA 95051, and the
Individual or Organization ("Licensee") accessing and otherwise using
this software in source or binary form and its associated
documentation ("the Software").

2. Subject to the terms and conditions of this BeOpen Python License
Agreement, BeOpen hereby grants Licensee a non-exclusive,
royalty-free, world-wide license to reproduce, analyze, test, perform
and/or display publicly, prepare derivative works, distribute, and
otherwise use the Software alone or in any derivative version,
provided, however, that the BeOpen Python License is retained in the
Software, alone or in any derivative version prepared by Licensee.

3. BeOpen is making the Software available to Licensee on an "AS IS"
basis. BEOPEN MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR
IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, BEOPEN MAKES NO AND
DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE SOFTWARE WILL NOT
INFRINGE ANY THIRD PARTY RIGHTS.

4. BEOPEN SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF THE
SOFTWARE FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS
AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE SOFTWARE, OR ANY
DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.

5. This License Agreement will automatically terminate upon a material
breach of its terms and conditions.

6. This License Agreement shall be governed by and interpreted in all
respects by the law of the State of California, excluding conflict of
law provisions. Nothing in this License Agreement shall be deemed to
create any relationship of agency, partnership, or joint venture
between BeOpen and Licensee. This License Agreement does not grant
permission to use BeOpen trademarks or trade names in a trademark
sense to endorse or promote products or services of Licensee, or any
third party. As an exception, the "BeOpen Python" logos available at
http://www.pythonlabs.com/logos.html may be used according to the
permissions granted on that web page.

7. By copying, installing or otherwise using the software, Licensee
agrees to be bound by the terms and conditions of this License
Agreement.

CNRI LICENSE AGREEMENT FOR PYTHON 1.6.1
---------------------------------------

1. This LICENSE AGREEMENT is between the Corporation for National
Research Initiatives, having an office at 1895 Preston White Drive,
Reston, VA 20191 ("CNRI"), and the Individual or Organization
("Licensee") accessing and otherwise using Python 1.6.1 software in

(continues on next page)
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source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, CNRI
hereby grants Licensee a nonexclusive, royalty-free, world-wide
license to reproduce, analyze, test, perform and/or display publicly,
prepare derivative works, distribute, and otherwise use Python 1.6.1
alone or in any derivative version, provided, however, that CNRI's
License Agreement and CNRI's notice of copyright, i.e., "Copyright (c)
1995-2001 Corporation for National Research Initiatives; All Rights
Reserved" are retained in Python 1.6.1 alone or in any derivative
version prepared by Licensee. Alternately, in lieu of CNRI's License
Agreement, Licensee may substitute the following text (omitting the
quotes): "Python 1.6.1 is made available subject to the terms and
conditions in CNRI's License Agreement. This Agreement together with
Python 1.6.1 may be located on the Internet using the following
unique, persistent identifier (known as a handle): 1895.22/1013. This
Agreement may also be obtained from a proxy server on the Internet
using the following URL: http://hdl.handle.net/1895.22/1013".

3. In the event Licensee prepares a derivative work that is based on
or incorporates Python 1.6.1 or any part thereof, and wants to make
the derivative work available to others as provided herein, then
Licensee hereby agrees to include in any such work a brief summary of
the changes made to Python 1.6.1.

4. CNRI is making Python 1.6.1 available to Licensee on an "AS IS"
basis. CNRI MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR
IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, CNRI MAKES NO AND
DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON 1.6.1 WILL NOT
INFRINGE ANY THIRD PARTY RIGHTS.

5. CNRI SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
1.6.1 FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS
A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON 1.6.1,
OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material
breach of its terms and conditions.

7. This License Agreement shall be governed by the federal
intellectual property law of the United States, including without
limitation the federal copyright law, and, to the extent such
U.S. federal law does not apply, by the law of the Commonwealth of
Virginia, excluding Virginia's conflict of law provisions.
Notwithstanding the foregoing, with regard to derivative works based
on Python 1.6.1 that incorporate non-separable material that was
previously distributed under the GNU General Public License (GPL), the
law of the Commonwealth of Virginia shall govern this License
Agreement only as to issues arising under or with respect to
Paragraphs 4, 5, and 7 of this License Agreement. Nothing in this
License Agreement shall be deemed to create any relationship of
agency, partnership, or joint venture between CNRI and Licensee. This
License Agreement does not grant permission to use CNRI trademarks or
trade name in a trademark sense to endorse or promote products or
services of Licensee, or any third party.

(continues on next page)
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8. By clicking on the "ACCEPT" button where indicated, or by copying,
installing or otherwise using Python 1.6.1, Licensee agrees to be
bound by the terms and conditions of this License Agreement.

ACCEPT

CWI LICENSE AGREEMENT FOR PYTHON 0.9.0 THROUGH 1.2
--------------------------------------------------

Copyright (c) 1991 - 1995, Stichting Mathematisch Centrum Amsterdam,
The Netherlands. All rights reserved.

Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted,
provided that the above copyright notice appear in all copies and that
both that copyright notice and this permission notice appear in
supporting documentation, and that the name of Stichting Mathematisch
Centrum or CWI not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior
permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS, IN NO EVENT SHALL STICHTING MATHEMATISCH CENTRUM BE LIABLE
FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

gRINN makes use of and includes several open-source software:

PyQt5 is distributed with gRINN. PyQt5 is dual licensed on all platforms under the Riverbank Commercial License
and the GPL v3.

NumPy is distributed with gRINN. NumPy is available under NumPy license:

pandas is distributed with gRINN. pandas is available under BSD 3-Clause License.

networkx is distributed with gRINN. networkx is available under a BSD license:

ProDy is distributed with gRINN. ProDy is available under MIT license:

ProDy: A Python Package for Protein Dynamics Analysis

Copyright (C) 2010-2014 University of Pittsburgh

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR

(continues on next page)
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IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

MDTraj is distributed with gRINN. MDtraj is available under the LPGL.

PyMol (open source version 1.9.0) is distributed with gRINN. PyMol is available under the CNRI Python License.

matplotlib (v2.0.2) is distributed with gRINN. matplotlib is available under matplotlib license:

1. This LICENSE AGREEMENT is between the Matplotlib Development Team (“MDT”), and the
→˓Individual or Organization (“Licensee”) accessing and otherwise using matplotlib
→˓software in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, MDT hereby grants
→˓Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze,
→˓test, perform and/or display publicly, prepare derivative works, distribute, and
→˓otherwise use matplotlib 2.0.2 alone or in any derivative version, provided,
→˓however, that MDT’s License Agreement and MDT’s notice of copyright, i.e.,
→˓“Copyright (c) 2012-2013 Matplotlib Development Team; All Rights Reserved” are
→˓retained in matplotlib 2.0.2 alone or in any derivative version prepared by
→˓Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates
→˓matplotlib 2.0.2 or any part thereof, and wants to make the derivative work
→˓available to others as provided herein, then Licensee hereby agrees to include in
→˓any such work a brief summary of the changes made to matplotlib 2.0.2.

4. MDT is making matplotlib 2.0.2 available to Licensee on an “AS IS” basis. MDT
→˓MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF EXAMPLE, BUT
→˓NOT LIMITATION, MDT MAKES NO AND DISCLAIMS ANY REPRESENTATION OR WARRANTY OF
→˓MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF MATPLOTLIB
→˓2.0.2 WILL NOT INFRINGE ANY THIRD PARTY RIGHTS.

5. MDT SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF MATPLOTLIB 2.0.2 FOR ANY
→˓INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS A RESULT OF MODIFYING,
→˓DISTRIBUTING, OR OTHERWISE USING MATPLOTLIB 2.0.2, OR ANY DERIVATIVE THEREOF, EVEN
→˓IF ADVISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its
→˓terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of
→˓agency, partnership, or joint venture between MDT and Licensee. This License
→˓Agreement does not grant permission to use MDT trademarks or trade name in a
→˓trademark sense to endorse or promote products or services of Licensee, or any
→˓third party.

8. By copying, installing or otherwise using matplotlib 2.0.2, Licensee agrees to be
→˓bound by the terms and conditions of this License Agreement.
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1.11.3 Intellectual Property and Ownership

gRINN Developers shall at all times retain ownership of the Software as originally downloaded by you and all sub-
sequent downloads of the Software by you. The Software (and the copyright, and other intellectual property rights
of whatever nature in the Software, including any modifications made thereto) are and shall remain the property of
gRINN Developers.

gRINN Developers reserves the right to grant licences to use the Software to third parties.

1.11.4 Termination

This EULA agreement is effective from the date you first use the Software and shall continue until terminated. You
may terminate it at any time upon written notice to gRINN Developers.

It will also terminate immediately if you fail to comply with any term of this EULA agreement. Upon such termination,
the licenses granted by this EULA agreement will immediately terminate and you agree to stop all access and use of
the Software. The provisions that by their nature continue and survive will survive any termination of this EULA
agreement.

1.11.5 Governing Law

This EULA agreement, and any dispute arising out of or in connection with this EULA agreement, shall be governed
by and construed in accordance with the laws of Republic of Turkey.
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